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Preface
The Lightscape Visualization System 

manuals are comprehensive 

documents that contain all the 

information you need to learn and 

use Lightscape efficiently and 

effectively.
vii



There are three Lightscape Visualization System manuals:

■ The Lightscape Visualization System Version 3 Getting Started 
manual describes the basic concepts of the Lightscape 
technology and process, and the fundamentals of the user 
interface. 

■ The Lightscape Visualization System Version 3 User’s Guide 
provides in-depth explanations of the techniques and 
concepts required to set up, process, and render a 
Lightscape solution. 

■ The Lightscape Visualization System Version 3 Tutorials manual 
provides step-by-step examples of the procedures discussed 
in the user’s guide.

The following information is available online in the Lightscape 
On-line Help.

■ The Task List provides step by step “How to” instructions 
for performing the procedures discussed in the user’s guide.

■ The Reference Guide provides detailed explanations of 
each menu item and dialog box in the Lightscape interface. 
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Conventions Used 
in This Book

Before you start using your Lightscape application, you should 
be familiar with the typographical conventions used in this 
manual.

Convention Type of Information

Boldface Used for program commands, such as lid2cibse or lid2ies.

Italic Used for emphasis and when a new term is introduced.

Monospace Used for what you see on your screen such as field syntax and macro 
listings, and unspecified information, such as suggested syntax and 
macro samples you need to provide. This typeface is shown in 
Courier. For example, if the instruction says your batch file should 
read: lsray -aa 4 -vf view1.vw solution1.ls image1.tif

you would see that text in your batch file.

Bold monospace  Used for specific text you enter. This typeface is shown in 
Courier bold. For example, if the instruction says “type cd 
projects ,” you would type the letters cd  followed by a space and 
then type projects . This typeface is also used for keys that you 
press on the keyboard, either singly (for example, Enter , Return , 
Esc ) or in combination (for example Ctrl+C ).

Bol d Italic monospace Used for place holders for items or filenames you must provide. This 
typeface is shown in Courier bold italic. As in the previous example, 
if the instruction says “type cd directory_name ,” you would 
replace directory_name  with the name of the directory. For a 
directory called “projects”, you would type cd projects . 

News Gothic typeface Used for things that you click, such as buttons and icons, or that you 
choose from menus and their submenus. For example, click Apply; 
choose New from the File menu.

> The > symbol indicates that you are to choose an item from a menu 
or submenu. For example, File > Parameters > Load means that you are 
to choose Load from the Parameters submenu of the File menu.
Conventions Used in This Book ix
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 Chapter 1
The Basics
Lightscape is an advanced 

visualization system for generating 

accurate lighting simulations of 

three-dimensional models. This 

chapter provides an introduction 

to the technology used in 

Lightscape. You should have a basic 

understanding of this technology to 

use the software effectively.
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About Lightscape Lightscape is an advanced lighting and visualization application 
that focuses on creating accurate images of how a 3D model of 
an object or space would appear if physically built. Lightscape is 
an application offering both radiosity and ray tracing technology 
combined with a physically based interface for defining lights 
and materials. Lightscape offers many unique advantages over 
other rendering technologies, including the following:

■ Lighting
The radiosity technology of Lightscape produces accurate 
photometric simulations of diffuse light propagation in an 
environment. Subtle but significant lighting effects, such as 
direct and indirect diffuse lighting, soft shadows, and color 
bleeding between surfaces produce images of natural 
realism not attainable with other rendering techniques. 
Because it supports industry-standard photometric formats 
and natural daylighting, Lightscape is a powerful tool for 
design visualization and analysis.

■ Interactivity
The result of a radiosity solution is not just a single image 
but a full 3D representation of the light distribution in an 
environment. Because the lighting is precalculated, 
Lightscape can display specific views of a fully rendered 
model much faster than with traditional computer graphic 
techniques. With hardware acceleration, it is often possible 
to move interactively through rendered environments. 
High-quality walkthrough animations for film or video can 
be generated in a fraction of the time required with other 
professional animation systems.
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■ Progressive Refinement
Unlike other techniques, a Lightscape solution provides 
instant visual feedback, which continues to improve in 
quality over time. At any stage in the processing, you can 
alter a surface material or lighting parameter and the 
system will compensate and display the new results without 
having to start the process over. The progressive 
refinement radiosity algorithms implemented in Lightscape 
give you precise control over the quality of visualization 
required to perform any given design or production task.

Computer Graphics  
Rendering

This section provides a brief overview of computer graphics 
rendering and a conceptual understanding of the techniques 
available with Lightscape. This information will help you decide 
which technique is most suitable for the visualization task you 
want to perform. 

A 3D model contains geometric data defined in relationship to 
a 3D Cartesian coordinate system. This system is sometimes 
referred to as world space. The model may also contain other 
information about the material of each of the objects and the 
lighting. The image on a computer monitor is made up of a 
large number of illuminated dots called pixels. The task in 
creating a computer graphics image of a geometric model is to 
determine the color for each pixel on the screen (screen space) 
based on the model information and a specific viewpoint.

The color of any specific point on a surface in a model is a 
function of the physical material properties of that surface and 
the light that illuminates it. Two general shading algorithms—
local illumination and global illumination—are used to describe 
how surfaces reflect and transmit light.
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Local Illumination Local illumination algorithms describe only how individual 
surfaces reflect or transmit light. Given a description of light 
arriving at a surface, these mathematical algorithms predict the 
intensity, spectral character (color), and distribution of the 
light leaving that surface. The next task is to determine where 
the light arriving at the surface originates. A simple rendering 
algorithm considers only the light coming directly from the 
light sources themselves in the shading. 

Global Illumination In considering more accurate images, however, it is important 
to take into account not only the light sources themselves, but 
also how all the surfaces and objects in the environment 
interact with the light. For example, some surfaces block light, 
casting shadows on other surfaces; some surfaces are shiny, in 
which case we see in them the reflections of other surfaces; 
some surfaces are transparent, in which case we see other 
surfaces through them; and some surfaces reflect light onto 
others. Global illumination algorithms are rendering algorithms 
that take into account the ways in which light is transferred 
between the surfaces in the model.

Lightscape uses two global illumination algorithms. One 
technique is called ray tracing; the other is called radiosity. 
Before explaining how these techniques work, it is useful to 
have a basic understanding of how, in the physical world, light 
is distributed in an environment. Consider, for example, the 
simple room shown in Figure 1-1.
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Figure 1-1. Global Illumination in a Room

This room has one light source. One theory of light allows us to 
consider the light in terms of discrete particles called photons, 
which travel out from the light source until they encounter 
some surface in the room. Depending on the material of the 
surface, some of these photons, traveling with particular 
wavelengths, are absorbed, while others are scattered back out 
into the environment. The fact that photons traveling at a 
particular wavelength are absorbed while others are not is what 
determines the color (also referred to as the spectral reflectance) 
of the surface. 
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The way a surface reflects photons depends primarily on its 
smoothness. Surfaces that are rough tend to reflect photons in 
all directions (Figure 1-2). These are known as diffuse surfaces 
and this type of reflection is known as diffuse reflection. A wall 
painted with flat paint is a good example of a diffuse surface.

Very smooth surfaces reflect the photons in one direction 
(Figure 1-3), at an angle equal to the angle at which they arrive 
at the surface (angle of incidence). These surfaces are known as 
specular surfaces and this type of reflection is known as specular 
reflection. A mirror is an example of a perfectly specular 
surface. Of course, many materials display some degree of both 
specular and diffuse reflection. 

The final illumination of the room is determined by the 
interaction between the surfaces and the billions of photons that 
are emitted from the light source. At any given point on a 
surface, it is possible that photons have arrived directly from 
the light source (direct illumination) or else indirectly through 
one or more bounces off some other surfaces (indirect 
illumination). If you were standing in the room, a very small 
number of the total photons in the room would enter your eye 

Figure 1-2. Diffuse Reflection Figure 1-3. Specular 
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and stimulate the rods and cones of your retina. This 
stimulation would, in effect, form an image that is perceived by 
your brain (Figure 1-1).

Computers replace the rods and cones of a retina with the 
pixels of the computer screen. One goal of a global illumination 
algorithm is to recreate, as accurately as possible, what you 
would see if you were standing in a real environment. A second 
goal is to accomplish this task as quickly as possible; ideally in 
real time (30 images per second). There is currently no single 
global illumination algorithm that can accomplish both of these 
goals. 

Ray Tracing One of the first global illumination algorithms to be developed 
is known as ray tracing. In ray tracing it is recognized that while 
there may be billions of photons traveling about the room, the 
photons you primarily care about are the ones that enter the 
eye. The algorithm works by tracing rays backward, from each 
pixel on the screen into the 3D model. In this way, it computes 
only the information needed to construct the image. To create 
an image using ray tracing, the following procedure is 
performed for each pixel on the computer screen (Figure 1-4):

1. Trace a ray back from the eye position, through the pixel 
on the monitor, until it intersects with a surface.

2. The model description provides the reflectivity of the 
surface, but not the amount of light reaching that surface. 
To determine the total illumination, trace a ray from the 
point of intersection to each light source in the 
environment (shadow ray). If the ray to a light source is not 
blocked by another object, use the light contribution from 
that source to calculate the color of the surface. 
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3. The intersected surface may be shiny or transparent. In this 
case the algorithm also must determine what is seen in or 
through the surface being processed. Steps 1 and 2 are 
repeated in the reflected (and, in the case of transparency, 
transmitted) direction until another surface is encountered. 
The color at the subsequent intersection point is calculated 
and factored into the original point.

4. If the second surface is yet again a reflective or transparent 
surface, the ray tracing process repeats once again, and so 
on, until a maximum number of iterations is reached or 
until no more surfaces are intersected. 

Figure 1-4. Ray tracing
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Ray tracing is a very versatile algorithm because of the large 
range of lighting effects it can model. It can accurately account 
for the global illumination characteristics of direct illumination, 
shadows, specular reflections (for example, mirrors), and 
refraction through transparent materials. The main 
disadvantage of ray tracing is that the process can be slow and 
computationally expensive for environments of even moderate 
complexity. 

Another significant disadvantage of ray tracing is that it does 
not account for one very important characteristic of global 
illumination—diffuse interreflections.

Traditional ray tracing techniques accurately account for only 
the light arriving directly from the light sources themselves. 
But, as shown in the room example, light does not only arrive 
at a surface from the light sources (direct lighting), it also 
arrives from other surfaces (indirect lighting). If you ray trace 
an image of the table, as shown in the example, the area under 
the table appears black because it receives no direct light from 
the light source. You know from experience, however, that 
this area would not really be completely dark because of the 
light it would receive from the surrounding walls and floor.

Traditional ray tracing techniques often refer to this indirect 
illumination as ambient light. They usually account for it by 
simply adding an arbitrary value that has no correlation to the 
physical phenomena of indirect illumination and that is constant 
throughout space. This often causes ray traced images to appear 
very flat. This is particularly true for architectural 
environments, which typically contain mostly diffuse surfaces.
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Radiosity To address some of the shortcomings of the ray tracing 
algorithm, researchers began investigating alternate techniques 
for calculating global illumination.

In the early 1960s thermal engineers developed methods for 
simulating the radiative heat transfer between surfaces. Their 
goal was to determine how their designs would perform in 
various applications such as furnaces and engines. In the mid-
1980s, computer graphics researchers began investigating the 
application of these techniques for simulating light propagation.

Radiosity, as this technique is called in the computer graphics 
world, differs fundamentally from ray tracing. Rather than 
determining the color for each pixel on a screen, radiosity 
calculates the intensity for discrete points in the environment.

Radiosity accomplishes this by first dividing the original 
surfaces into a mesh of smaller surfaces known as elements. The 
radiosity process calculates the amount of light distributed from 
each mesh element to every other mesh element. It then stores 
the final radiosity values for each element of the mesh 
(Figure 1-5).

Once this light distribution has been calculated, specific views 
of the environment can be rapidly displayed on the screen 
(often in real time) using simple hardware-assisted scan-line 
techniques. This property is often referred to as view 
independence, because the light distribution is precalculated for 
the whole environment and does not have to be recalculated for 
each specific view. Ray tracing, on the other hand, is known as 
a view-dependent algorithm, because the lighting has to be 
recalculated for each view.
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Figure 1-5. Radiosity

Early versions of the radiosity algorithm had to completely 
calculate the distribution of the light among all the mesh 
elements before they could display any useful results on the 
screen. Even though the end result was view independent, the 
preprocessing took considerable time. In 1988 this 
preprocessing portion of the radiosity algorithm was 
reformulated. The new technique, referred to as progressive 
refinement radiosity, allows users to obtain immediate visual 
results, which progressively improve in accuracy and visual 
quality. 
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The progressive refinement radiosity algorithm used in 
Lightscape works in the following way:

1. The surfaces are meshed into a set of relatively large 
elements. The initial elements can be subdivided 
automatically into smaller elements in areas where a 
significant intensity difference is detected between adjacent 
mesh elements (for example, across shadow boundaries).

2. Light is distributed from each luminaire to all surfaces in 
the environment. (A luminaire is a light fixture, with one 
or more lamps and housing.) In this calculation, surfaces 
can block other surfaces, casting shadows.

3. Depending on the characteristics of the surface material, 
some of the energy reaching a particular mesh element is 
absorbed, while the remaining energy is reflected into the 
environment. An important assumption in radiosity is that 
all the surfaces are “ideal diffuse” (Lambertian)—that is, 
they reflect light equally in all directions. 

4. After distributing the energy from each direct light source 
(direct illumination), the progressive radiosity algorithm 
continues by checking all the surfaces and determining 
which surface has the most energy to be reflected. This 
surface is then treated as an area light source emitting the 
reflected energy to all the other surfaces in the 
environment (indirect illumination). 

5. The process continues until most of the energy in the 
environment has been absorbed (energy equilibrium) and 
the simulation reaches a state of convergence. 

Each distribution of light from a luminaire or surface, as just 
described, is called an iteration.
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The number of iterations required for a simulation to reach a 
state of convergence varies depending on the complexity of the 
environment. Because the iterations are sorted to calculate the 
surfaces with the greatest energy first, the rate of convergence 
for the radiosity solution is much faster in the beginning. 
Toward the end, the amount of energy remaining to be 
distributed is so small that there is no perceptible difference in 
the resulting images from one iteration to the next. Therefore, 
while it may take a large number of iterations for a solution to 
reach full convergence, typically you can interrupt the process 
before this point is reached, because an acceptable solution has 
been obtained.

Radiosity and
Ray Tracing
Differences

Although the ray tracing and radiosity algorithms are very 
different, they are in many ways complementary. Each 
technique has its own unique set of advantages and 
disadvantages.

The ray tracing algorithm has the following advantages:

■ Accurately rendered direct illumination, shadows, specular 
reflections, and transparency effects

■ Memory efficiency

Ray tracing has the following disadvantages:

■ Computationally expensive; the time required to produce 
an image is greatly affected by the number of light sources

■ View dependent—Process must be repeated for each view

■ Does not account for diffuse interreflections
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The radiosity algorithm has the following advantages:

■ Calculations of diffuse interreflections between surfaces

■ View-independent solutions for fast display of arbitrary 
views

■ Immediate visual results, which progressively improve in 
accuracy and quality

The radiosity algorithm has the following disadvantages:

■ 3D mesh requires more memory than the original surfaces

■ Surface-sampling algorithm is more susceptible to imaging 
artifacts than ray tracing

■ Does not account for specular reflections or transparency 
effects

Neither radiosity nor ray tracing offers a complete solution for 
simulating all global illumination effects. Radiosity excels at 
rendering diffuse-to-diffuse interreflections and ray tracing 
excels at rendering specular reflections. 

By merging both techniques, Lightscape offers the best of 
both. In Lightscape, it is possible to combine a ray-tracing 
postprocess with a specific view of a radiosity solution to add 
specular reflections and transparency effects. In this situation, 
the radiosity solution replaces the inaccurate ambient constant 
used in many programs with accurate indirect illumination 
values. This leads to a much more realistic image. In addition, 
because the direct lighting can be calculated in the radiosity 
solution, the ray tracer does not have to cast any shadow rays, 
only reflected or transmitted rays. This greatly reduces the 
time required to ray trace an image. By integrating both 
techniques, Lightscape offers a full range of visualization 
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possibilities, from fast, interactive lighting studies to 
combination radiosity/ray traced images of exceptional quality 
and realism.

Photometry Lightscape is founded on a physically based simulation of the 
propagation of light through an environment. The results are 
not only highly realistic renderings, but also accurate 
measurements of the distribution of light within the scene. This 
section is a brief introduction to the quantities used to 
characterize these measurements.

You specify the brightness of a luminaire in Lightscape using 
these physically based quantities. You can obtain these values 
directly from the manufacturers of various lamps and 
luminaires. A table of some common lamp types is provided in 
Appendix G, “Common Lamp Values,” of the Lightscape 
Visualization System User’s Guide.

There are several theories that describe the nature of light. For 
this discussion, light is radiant energy capable of producing a 
visual sensation in a human observer.

When designing a lighting system, you are interested in 
evaluating its performance in terms of the human visual 
response. Thus photometry was developed to measure light 
taking into account the psychophysical aspects of the human 
eye/brain system.

The lighting simulation system uses four photometric quantities: 

■ Luminous flux 
■ Illuminance 
■ Luminance
■ Luminous intensity
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Luminous flux is the quantity of light energy per unit time 
arriving, leaving, or going through a surface. The unit of 
luminous flux is the lumen (lm), used in both the International 
System (SI) of Units and in the American System (AS) of Units. 
If you think of light as particles (photons) moving through 
space, then the luminous flux of a light beam arriving at a 
surface is proportional to the number of particles hitting the 
surface during a time interval of 1 second.

Illuminance is the luminous flux incident on a surface of unit 
area. This quantity is useful for describing the level of 
illumination incident on a surface without making the 
measurement dependent on the size of the surface itself. The SI 
unit of illuminance is the lux (lx), equal to 1 lumen per square 
meter. The corresponding AS unit is the footcandle (fc), 
equivalent to 1 lumen per square foot.

Part of the light incident on a surface is reflected back into the 
environment. Luminance is the light reflected off a surface in a 
particular direction and is the quantity converted to display 
colors to generate a realistic rendering of the scene. Luminance 
is measured in candelas per square meter or candelas per square 
inch. The candela was originally defined as the luminous 
intensity emitted by a single wax candle.

Finally, luminous intensity is the light energy per unit time 
emitted by a point source in a particular direction. The unit of 
measure of luminous intensity is the candela. Luminous 
intensity is used to describe the directional distribution of a 
light source—that is, to specify how the luminous intensity of a 
light source varies as a function of the outgoing direction.
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 Chapter 2
The Lightscape 
Process
This chapter provides a summary 

of the general process for using 

Lightscape. Each step of this process 

is explained in greater detail in the 

Lightscape Visualization System User’s 

Guide. 
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The Lightscape process consists of three major stages:

■ The Preparation stage
■ The Solution stage
■ The Output stage

Figure 2-1. Overview of the Lightscape Visualization Process
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The Preparation Stage During the Preparation stage, you perform a number of 
operations  to prepare geometric data for processing during the 
Solution stage. These operations include the following:

■ Import the geometry.

Lightscape provides import filters for several file formats.

■ Define what materials the surfaces are made of.

Lightscape simulates the interaction of light between 
surfaces in the model. Accurately representing the material 
properties of surfaces is important for achieving meaningful 
results.

■ Ensure that the surfaces of the model are properly oriented.

Some modeling systems allow for the creation of infinitely 
thin surfaces. Because Lightscape is a physically based 
lighting simulation system, it is important to indicate which 
side of such a surface represents the desired physical side.

■ Define the photometric properties of the luminaires 
(lighting fixtures) used in the model.

Lightscape uses physically based lighting values to define 
the artificial light sources and natural light in a 3D model.

■ Add, delete, and move entities and luminaires as desired.

Lightscape provides a limited suite of tools you can use to 
modify the geometry of a model before processing a 
radiosity solution.

All the work that you perform during the Preparation stage is 
saved as a Lightscape Preparation model in a Lightscape 
Preparation (.lp) file.
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The Solution Stage During the Solution stage you run a radiosity solution on the 
geometry you prepared during the Preparation stage. Steps 
during this part of the process include the following:

■ Initiate the geometry.

Lightscape reduces the model to a set of surfaces that are 
optimized for the radiosity process. Once initiated, you can 
no longer manipulate the model geometry.

■ Define the processing parameters.

You define the global processing parameters (those that 
apply to the entire model) and any desired local processing 
parameters (those that apply to specific surfaces). Process 
parameters control the quality of the resulting radiosity 
solution. Setting the process parameters is a balancing act. 
Finer settings produce more accurate solutions and better 
quality images, but they also require more time and 
memory. 

■ Process the radiosity solution.

Lightscape calculates the diffuse light energy distribution 
for the model, both direct and indirect. This process is 
described in detail in Chapter 1, “The Basics.” 

■ Refine the radiosity solution.

You can interrupt the processing of the radiosity solution at 
any time to alter or fine tune the model’s appearance. You 
cannot change the model geometry, but you can change the 
characteristics of a material and the photometric properties 
of a luminaire. Once you make your changes, you can 
update the results of the radiosity solution by either 
continuing the processing from where you left off or by 
restarting the processing from the beginning.
2-4 Chapter 2, The Lightscape Process



You can save the results of the radiosity solution as a 3D 
Lightscape Solution model in a Lightscape Solution file (.ls). 

The Output Stage There are many ways you can use the results from a radiosity 
solution and Lightscape offers a variety of output options to 
support these uses. 

During the Output stage, you can render a Lightscape radiosity 
solution very quickly using OpenGL rendering or more 
accurately using the Lightscape ray tracer to add specular 
reflections and transparency effects to the final images. 
(OpenGL is an industry-standard Application Programming 
Interface for drawing 3D graphics.) You can also use the ray 
tracer to refine the definition of shadows by ray tracing direct 
light sources. The options you choose at this stage have an 
impact on the time required to generate an image; the choice 
you make depends on your intended use. The following uses 
are the most common:  

■ Animation Frames
■ Single Images
■ Virtual Reality
■ Lighting Analysis

Animation Frames With the Lightscape animation tools, you can create camera 
paths for generating walkthrough animations of your radiosity 
solutions. Even though the image-generation time is not as 
crucial as it is for doing real-time display, image generation 
time is still a significant issue because of the number of frames 
that must be created. The fastest display rates can be obtained 
by using only a radiosity solution; you can generate high-quality 
antialiased images very quickly with OpenGL rendering. 
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If you want to add specular reflections and accurate 
transparency effects, you can use ray tracing on each frame to 
render these effects. Although ray tracing increases the time 
required to generate a frame, it is not necessarily an impractical 
option for animation production. If you ray trace animation 
frames, you should render them using the batch ray tracing 
program included with Lightscape. This gives you greater 
efficiency in the rendering process.

Single Images Typically, the single image demands the highest level of quality. 
Lightscape has the capability to produce images of any 
resolution. If you use the image from a radiosity solution only, 
you can create the image very quickly with OpenGL rendering.

To obtain the most accurate representation, however, you 
should ray trace the image. In addition to adding specular 
reflections and accurate transparency effects, you can also 
specify that you want the system to ray trace some or all of the 
light sources. Such specification produces the most accurate-
looking shadows and lighting effects for those light sources and 
results in the highest image quality. This process also requires 
the greatest amount of time, especially if there are many light 
sources to ray trace. 

Virtual Reality If your goal is to produce a virtual reality environment for real-
time walkthrough and interaction, you cannot use ray tracing. 
You must strive for the highest quality from the most compact 
and efficient model using the radiosity process alone. Because 
the radiosity solution results in a simple polygonal mesh with 
specific radiosity values (converted to RGB colors) stored at the 
vertices, results can be displayed very rapidly using OpenGL 
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rendering. The speed of interaction depends on the complexity 
of the environment and the number of mesh elements (that is, 
polygons) generated during the radiosity solution. Display can 
also be accelerated using an OpenGL-compliant graphics 
accelerator board.

Lightscape supports OpenGL texture mapping, but can only 
display environments with texture mapping in real time on 
platforms that offer hardware support for it. If hardware 
support is present, you can use the Mesh to Texture tool to 
reduce geometric complexity in the environment by converting 
meshes and geometry into texture maps. Note that the 
OpenGL display libraries have been developed primarily for 3D 
interactive display and the rendering capabilities offered with 
OpenGL are not always compatible with efforts to produce 
physically accurate simulations. (See the Lightscape Visualization 
System User’s Guide.) 

For example, during normal display Lightscape uses OpenGL 
blending techniques to create the effect of transparency for 
surfaces made of transparent materials. Although this can be 
accomplished in OpenGL with little penalty on display rates, 
what you see in the display is not the same effect you would see 
if you were to ray trace the image. The ray traced rendering 
produces a much more accurate representation.

Lightscape’s radiosity solution can also be exported into 
Inventor and VRML formats. (See the Lightscape Visualization 
System User’s Guide.) This data can then be used in specialized 
display and virtual reality applications. 
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Lighting Analysis If your primary interest is in lighting analysis, Lightscape 
provides a variety of tools for visualizing the lighting data 
contained in the radiosity solution. Generally, radiosity 
solutions for lighting analysis can be created coarser (and faster) 
than those required to produce images. 

Project Management As you work with Lightscape, you generate a considerable 
amount of data including Preparation files, Solution files, and 
library files. (All Lightscape file types are summarized in 
Appendix F, “Lightscape File Types,” of the Lightscape 
Visualization System User’s Guide.) In addition, you use files 
generated from other sources such as DXF files, texture maps, 
and photometric files. Before you start using Lightscape, you 
should devise a strategy for managing the large amount of data 
that you generate over time. Lightscape does not impose any 
particular structure on how to manage your data. This gives 
you the flexibility to establish a system that works best with any 
existing system you may already have implemented for other 
CAD or animation programs.

In general, you organize the files that you generate into two 
categories—files that relate to a specific project, called local 
files, and files that contain information you want to reuse or 
share in a number of projects, called global files. 

Over time, as you add additional libraries and projects, your 
file structure may look like the example shown in Figure 2-2. 

Figure 2-2 represents one possible solution. For example, you 
may decide to place your project folders into the folders in 
which you created the original model. The important concept 
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to recognize is that an organized file structure and careful 
attention to maintaining it properly will save you considerable 
time and effort in the long term. 

 

Figure 2-2. One Possible File Structure
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 Chapter 3
User Interface
The Lightscape user interface is 

designed to allow you easy access to 

a suite of interactive tools for 

preparing models for radiosity 

processing and working with the 

results. This chapter discusses the 

overall layout and general approach 

to using these tools.
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This chapter covers the following topics:

■ Starting Lightscape
■ Screen Layout
■ The Lightscape Interface
■ Toolbars, Context Menus, and Dialog Boxes
■ The Mouse
■ File Controls
■ Viewing the Model
■ Display Controls
■ Selecting Entities

Starting Lightscape To start Lightscape, double-click the Lightscape application 
icon. By default, this icon is located in the Lightscape 
Visualization System program folder.

If you are running Windows NT 4.0 or Windows 95, you can 
also start Lightscape by choosing it from the Start menu.
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Screen Layout Figure 3-1 shows a typical screen layout.

Figure 3-1. The Lightscape Interface

Layers Table

Materials
Table

Blocks Table

Luminaires
Table

Menu Bar

Status Bar Typical Dialog Box

Toolbar

Graphic Window
Screen Layout 3-3



The Lightscape 
Interface

The Lightscape interface, shown in Figure 3-1, consists of views 
into the five major components of the Lightscape model. The 
largest and most important is the Graphic Window. This is 
located, by default, in the top left corner and occupies the 
majority of the screen. The four other components, the Layers, 
Materials, Blocks, and Luminaires tables, are grouped together 
in a vertical bar of list windows on the right side of the screen. 
You can reposition and resize all of these windows as required. 

The Lightscape menu bar occupies the upper portion of the 
Graphic Window. Directly below the menu bar is the default 
area for the displayed toolbars. A status bar attached to the 
bottom of the Graphic Window communicates information as 
required. The title bar displays the name of the current file 
loaded and displayed in the Graphic Window.

You can find editing operations in a variety of locations by using 
the pulldown menus on the Lightscape menu bar, by clicking 
the appropriate icon in a toolbar, or by using the right mouse 
button to bring up a context menu. 

As you choose editing operations, additional dialog boxes 
appear as appropriate. These dialog boxes generally appear in 
the area across the bottom of the screen away from the five 
major windows. 
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Graphic Window Figure 3-2 shows the Lightscape Graphic Window. 

Figure 3-2. The Graphic Window

You display and edit the geometry of the current model in the 
Graphic Window. You can change how Lightscape views and 
displays the model using several projection and display modes 
described below.

In the Graphic Window, Lightscape supports several different 
orthogonal view projection modes, as well as perspective view 
projection. There are also dynamic (interactive) view controls  
you can use to quickly move around the model in each of the 
projections. 

There are several modes that control the way Lightscape 
displays the model. For example, the model can be displayed in 
wireframe or solid mode. 

Graphic Window
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The Graphic Window normally holds only a single view of the 
model at any one time. However, during animation editing, 
Lightscape breaks the Graphic Window into four concurrent 
views to aid in the creation and editing of the motion path.

An optional element of the Graphic Window is a set of X, Y, 
and Z axes indicating the current view orientation. Lightscape 
displays the X axis in red, the Y axis in green, and the Z axis in 
blue. You can toggle the axes display on and off by choosing 
Display > Show Axis. (This option does not display the scale of the 
model.) 

You select entities in the Graphic Window by clicking them 
with the left mouse button.

Layers Table The Layers Table contains a list of all the layers defined in the 
current model and indicates their state. A check mark to the 
left of the layer name indicates that the layer is on (active) and 
that the entities on that layer are currently being displayed in 
the Graphic Window. Double-clicking a layer name toggles its 
state on and off.

A “C” to the left of the layer name indicates it is the Current 
layer. Lightscape adds any new entities you add to the model on 
the Current layer. 

Clicking the right mouse button in the Layers Table displays the 
Layers context menu, which contains functions appropriate to 
the layer selection set. Figure 3-3 shows an example of the 
Layers Table and the Layers context menu. (For detailed 
information on layers, see the Lightscape Visualization System 
User’s Guide.)
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Figure 3-3. The Layers Table

Materials Table The Materials Table contains a list of all the materials currently 
available in the model. You assign materials to surfaces in the 
model to define their appearance and how light energy incident 
on the surfaces behave.

Clicking the right mouse button in the Materials Table displays 
a context menu with functions you can use to manipulate the 
materials in the table. Double-clicking any material name 
activates the Material Properties dialog box which contains 
tools for editing the characteristics of the selected materials.

Context Menu

Layers Table
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Figure 3-4 shows an example of the Materials Table and the 
Materials context menu. (For detailed information on 
materials, see the Lightscape Visualization System User’s Guide.) 

Figure 3-4. The Materials Table

Blocks Table The Blocks Table contains a list of all the blocks available in the 
model. A block in Lightscape is a grouping of entities (surfaces 
or other blocks) given a common name and an insertion point. 
Once you have defined a block, you can make repeated 
instances of it and place them into the model at a variety of 
locations, sizes, and orientations. Double-clicking any block 
name isolates the block for display and editing in the Graphic 
Window. The Blocks Table is only available during the 
Preparation stage.

Materials Table

Context Menu
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Clicking the right mouse button in the Blocks Table displays a 
context menu with functions you can use to manipulate the 
blocks in the table. Figure 3-5 shows an example of the Blocks 
Table and the Blocks context menu. (For detailed information 
on blocks, see the Lightscape Visualization System User’s Guide.) 

Figure 3-5. The Blocks Table

Luminaires Table The Luminaires Table contains a list of all the luminaires available 
in the model. A luminaire is a special type of block used to 
represent light fixtures in Lightscape. A luminaire includes a 
definition of photometric characteristics that control how light 
energy is emitted from the luminaire. In Preparation mode, 
double-clicking any luminaire name isolates the luminaire for 
display and editing in the Graphic Window and activates the 
Luminaire Properties dialog box, which contains settings for 
editing the luminaire’s photometric characteristics.

Blocks Table

Context Menu
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Clicking the right mouse button in the Luminaires Table 
displays a context menu with functions you can use to 
manipulate the luminaires in the table. Figure 3-6 shows an 
example of the Luminaires Table and the Luminaires context 
menu. (For detailed information on luminaires, see the 
Lightscape Visualization System User’s Guide.) 

Figure 3-6. The Luminaires Table

Luminaires Table

Context Menu
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Toolbars, Context 
Menus, and Dialog 
Boxes

Toolbars contain icons that represent specific operations. 
Context menus contain functions appropriate to the current 
window or to the selected entities. Dialog boxes contain 
additional functions and parameters related to the selected 
menu or toolbar icon. 

Toolbars When you position (or hold) the mouse cursor over a toolbar 
icon, a Tooltip below the cursor displays the name of the 
operation associated with that icon. Clicking the icon executes 
the operation. The default toolbars, which contain the most 
commonly used operations, are normally docked at the top of 
the Graphic Window. 

You can display multiple toolbars at one time and float or dock 
them as required. A docked toolbar is attached to any edge of 
the Graphic Window. A floating toolbar can be positioned 
anywhere on the screen. You can select which toolbars are 
displayed by choosing Tools > Toolbars. 

You dock a toolbar by positioning the cursor over the border of 
the toolbar and dragging it to an edge of the Graphic Window. 
You undock a toolbar by dragging it away from the edge of the 
Graphic Window.
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Context Menus Clicking with the right mouse button in the Graphic Window 
or one of the list windows displays a context menu.

For example, clicking the right mouse button in the Graphic 
Window when a surface is selected displays a context menu of 
functions that can be performed on the selected surface. 
Clicking the right mouse button in one of the list windows 
displays a context menu of functions that can be performed on 
the selected entities or on the list itself.

Dialog Boxes Certain operations display a dialog box you can use to access 
various related options. 

Some dialog boxes disappear once the operation has been 
completed. Other dialog boxes are persistent and remain until 
you explicitly close them, so you can make additional selections 
and repeat operations without having to reopen the dialog box. 
You can close persistent dialog boxes by double-clicking the 
control menu icon in the upper-left corner. 

Dialog boxes may contain several overlapping pages. You access 
the different pages by clicking the page tabs along the upper 
edge. 
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The Mouse Lightscape is designed for use with a two-button mouse. The 
left button is the action button. The right button displays a 
context menu based on the current location or selection. 

Moving the mouse and pressing the left button in the Graphic 
Window performs one of several actions, depending on the 
currently selected mouse mode. There are three general mouse 
modes:

■ Query Mode
In Query mode, clicking an entity in the Graphic Window 
displays information about that entity in the status bar. 
Layers and materials associated with the entity are also 
highlighted in the appropriate tables.

■ Select Mode
In Select mode, you use the mouse to select entities in the 
model. Selection options are discussed in “Selecting 
Entities” on page 3-32.

■ Dynamic View Modes
When you select a dynamic view mode such as Orbit or 
Rotate, dragging the mouse in the Graphic Window 
dynamically changes the display of the model in the 
window. The specific dynamic display modes are Orbit, 
Rotate, Zoom, Zoom Window, Pan, Dolly, Scroll, and Tilt. 
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File Controls Through the Standard toolbar, Lightscape provides tools for file 
and Help functions as well as an Undo function. The file control 
and Help functions are also available from the File and Help 
menus. The Undo function is also available from the Edit menu.

Figure 3-7. Standard Toolbar

New
Creates a new, empty Lightscape model. If any data is currently 
in memory, it is erased. In such cases, you are prompted to save 
the data if you have made changes since the last time you saved 
the model.

Open
Loads an existing Lightscape model file. The file can be either a 
Preparation file (.lp) or a Solution file (.ls). If any data is 
currently in memory, it is erased. In such cases, you are 
prompted to save the data.

The Append option in the Open dialog box lets you combine 
two or more Preparation or Solution files (you cannot mix the 
file types). The default is to overwrite any file currently loaded.

New Save

Undo

Print

Help Index

Context Help

Open
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Additionally, the Scale option (available when loading 
Preparation files) lets you specify a numeric factor by which all 
objects in the file will be scaled. 

Save
Saves the current Lightscape model. If the model has not been 
saved previously, this function defaults to Save As and 
Lightscape prompts you for a filename and location. If your 
model was previously saved, the Save function overwrites the 
previous file. To preserve the previous file, use Save As from 
the File menu.

Undo
Offers one level of undo for destructive actions. You can use 
the Undo function immediately after deleting items in the 
Layers, Materials, Blocks, or Luminaires tables. You can also 
use Undo after deleting surfaces or block/luminaire instances 
in the Graphic Window.

The Undo function restores the most recently deleted entity or 
entities even after you perform view modifications such as 
changing the projection mode or using the dynamic view 
controls. If, however, after deleting an entity you perform any 
function that involves a change to the Lightscape database, such 
as renaming a material, adding a block instance, or saving the 
file, the Undo buffer is emptied and you can no longer reverse 
the previous action.

There is no Redo function. Also, the Undo function is not 
related to the Undo Zoom Window function in the View menu 
or the Undo button in the Create Surface dialog box.
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Print
Prints the current view of the model.

Help Index
Displays the Help index. This is equivalent to selecting the 
Index option in the Help menu.

Context Help
Enables getting quick help on any on-screen interface element. 
When you select the Context Help tool, the mouse cursor 
changes to a replica of the tool. Clicking on any toolbar item, 
table, or the Graphic Window displays information on that 
item. The Context Help function must be invoked separately 
for each time you request information on an item.

Viewing the Model Lightscape offers the following options for controlling the view 
of your model:

■ View Projection Modes
■ Dynamic View Controls
■ View Setup
■ View Extents
■ View Align
■ Set Viewport Size
■ View Files
■ Original
■ Undo Zoom Window
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View Projection Modes Lightscape provides the following view projections for viewing 
the model as shown in Figure 3-8:

■ Perspective view
■ Orthographic views 

Figure 3-8. View Projection Toolbar

The Lightscape perspective model uses a viewer position, a 
focus point, and a picture plane to create perspective views. 
Both the view setup and the dynamic view controls are built 
around these conventions, shown in Figure 3-9.

 

Figure 3-9. Perspective Conventions
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You can set up a view by specifying the locations for the viewer 
position, focus point, view angle, and picture plane, using the 
View Setup controls. There are also dynamic controls for 
moving around the model. 

Dynamic View
Controls

Lightscape provides dynamic view controls for changing the 
view of the model in the Graphic Window. You can access these 
controls by choosing the menu item, clicking the View Control 
tools shown in Figure 3-10, or by pressing a keyboard hotkey, 
as specified in Table 3-1. 

Figure 3-10. View Control Icons 

When you select a View Control tool (or when you press the 
Shift  key and a hotkey together), the current left button 
mode is terminated and the left button is used solely to 
dynamically change the view. Any action with the mouse in the 
display area is interpreted as an attempt to change the view, 
based on the view control selected. To return to the previous 
left button mode, you must explicitly reselect that mode.
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When you press a hotkey without the Shift  key, the current 
left button mode is suspended as long as the hotkey is pressed. 
Any action with the mouse in the display area is used to change 
the view. When you release the hotkey, the left button mode 
returns to the previous state. 

Only meaningful view controls are allowed for specific view 
projections, as described in Table 3-1.

Table 3-1.  Dynamic View Control 

View
Control

Toolbar
 Button Hotkey Description

Orbit o Rotates the viewer position about the focus point in all three axes. 
The direction of the mouse movement directly indicates the angle of 
the orbit motion. 

Perspective projection only. 

Rotate r Rotates the viewer position about an axis passing through the focus 
point and parallel to the Z axis. Again, the direction of the mouse 
movement directly indicates the angle of rotation. 

Perspective projection only. 

Zoom z The focal angle of the camera changes, but the viewer position and 
the focus point do not change. This is similar to a zoom lens on a 
photographic camera. Lightscape adjusts the size of the view frame 
on the picture plane accordingly.

Use a vertical mouse movement when zooming. Dragging upward on 
the screen reduces the field of view and zooms into the scene. 
Dragging downward increases the field of view and zooms out from 
the scene.

In perspective projections, zooming out a lot leads to distortions in 
the image (similar to a wide-angle lens on a camera). 

All projections.
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Zoom 
Window

w Drag a rectangle in the Graphic Window to zoom directly to a 
specific area. Use the View > Undo Zoom Window menu item to 
reset the view to the view that was used before the last zoom 
window. The Undo Zoom Window operation supports 10 levels of 
undo.

Pan p Moves the viewer position and the focus point together in the 
opposite direction from the direction you are dragging. The model 
appears to move with the mouse. 

Perspective projection only.

Dolly d Moves the viewer position forward or backward along the view path. 
Dragging upward moves the viewer position forward. Dragging 
downward moves the viewer position backward. You cannot dolly 
forward past the focus point. The dolly speed depends on the 
distance to the focus point.

Perspective projection only.

Table 3-1.  Dynamic View Control 
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Table 3-1.  Dynamic View Control (continued)

View 
Control

Toolbar 
Button Hotkey Description

Scroll s In orthographic projections, Scroll behaves exactly like a pan behaves 
in perspective projection.

In perspective projection, however, Scroll behaves differently. Unlike 
the other view options, scroll does not alter the perspective 
projection. Any lines that appeared parallel before the scroll remain 
parallel after the scroll. The result of a scroll is an off-center 
projection. 

It is generally difficult to predict the behavior of an off-center 
projection. If your camera behaves strangely, for example, zooming 
about a point not at the center of the window, it has probably been 
scrolled. In architectural photography, you often use a perspective 
correction lens to maintain parallel vertical lines in the image. You 
can obtain this effect in Lightscape by first setting a specific 
perspective view with the camera position and focus point at the 
same height. You can then scroll the resulting view to adjust the 
image plane as desired. 

All projections. 

Tilt t Rotates the model around an axis perpendicular to the screen. 
Change the View Tilt by dragging the mouse around an imaginary 
center point on the screen. The model rotates in the same direction 
as the mouse movement.
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View Setup You can define a specific view of your model by using the View 
Setup controls (View > Setup), as shown in Figure 3-11. 

Figure 3-11. View Setup Controls
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When you click the View Setup tool or choose the View > Setup 
menu item, the display changes to Top View mode and 
Lightscape displays a view frustum in red, superimposed on the 
model (Figure 3-11). Table 3-2 shows the controls that 
View > Setup provides for setting the view frustum. 

Table 3-2.  View Setup Controls

Controls Position

Viewer Position Sets the “camera” position. Select the Viewer 
Position option, if necessary, and click in the 
Graphic Window. You can also type explicit 
values in the input fields. Selecting a point in the 
Graphic Window does not set the Z (height) 
value.

Focus Point Sets the “Focus” point. Click the Focus Point 
option, if necessary, and click in the Graphic 
Window. You can also type explicit values in the 
input fields. Selecting a point in the Graphic 
Window does not set the Z (height) value.

Near Clip Plane Defines the location of the near clipping plane. 
Set the near clipping plane by entering the desired 
values in the input field or by adjusting the slider 
adjacent to the input field. Lightscape does not 
display entities in the model that are between the 
viewer position and the near clipping plane.

Far Clip Plane Defines the location of the far clipping plane. Set 
the far clipping plane by entering the desired 
values in the input field or by adjusting the slider 
adjacent to the input field. Lightscape does not 
display any entities in the model that are beyond 
the far clipping plane.
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Table 3-2.  View Setup Controls (continued)

View Extents View Extents displays all the entities in the model. It sets the 
focus point to the center of all visible entities and views the 
model from the front. Choose View > Extents to invoke this 
operation.

Controls Position

Field of View Adjusts the view angle of the view frustum. 
This changes the size of the view frame in 
relation to the picture plane. Change the Field 
of View by entering the desired values in the 
input field or by adjusting the slider adjacent to 
the input field.

Lightscape computes the Field of View from 
the Focal Length and the Film Size. If you 
explicitly change the Field of View, Lightscape 
adjusts the Focal Length and leaves the Film 
Size alone.

Tilt Rotates the model around an axis perpendicular 
to the screen. Change the Tilt by adjusting the 
slider from -180° through 180°.

Film Size (mm) Sets the virtual camera’s film size.

If you explicitly change the Film Size, Light-
scape adjusts the Focal Length and leaves the 
Field of View alone

Focal Length 
(mm)

Sets the virtual camera’s focal length.

If you explicitly change the Focal Length, 
Lightscape adjusts the Field of View and leaves 
the Film Size alone.
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View Align View Align uses an image file as the background in the Graphic 
Window. Interior models with windows show this background 
image through their transparent surfaces. This gives the illusion 
that the model sits in a particular exterior environment. The 
background image can be offset on the screen to correspond to 
an appropriate location in the model. 

The background image is only visible when the View Align 
dialog box is open. If you choose to render an image from the 
Rendering dialog box, the background image will not be 
included in the rendered image.

Set Viewport Size The viewport is the area of the Graphic Window containing an 
image of the model. The default value is Full Window. Use the 
Set Viewport Size option to select a different image size. You 
can choose from a number of different industry-standard image 
sizes, or type Width and Height values in the input fields.

You can also set the viewport size using the Resolution option 
in the Rendering dialog box.

View Original In addition to stored view files, there is one “built-in” view, 
called the Original view. The original view was the view setup 
when the model file was loaded. This view is always the first 
selection in the list of views.

Undo Zoom Window Undo Zoom Window restores the view to the view that was 
used before the last zoom window operation. Up to 10 levels of 
undo zoom window are supported.
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View Files You can save a specific view into a view file for use later in the 
project. For example, you may want to return quickly to a 
particular camera view or select a particular view when 
outputting an image.

When you save a view file, Lightscape adds its name to the 
bottom of the View pulldown menu. To change to a stored view, 
choose the view file from this menu.

Display Controls Lightscape offers a number of different display modes that 
change how the model appears in the Graphic Window. There 
are also display options that have an additional effect on the 
model’s appearance.

Display Modes You can select one of the following modes in which to 
interactively display the model.

Figure 3-12. Shading Toolbar
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Wireframe Mode
This option displays the model in wireframe mode. Lightscape 
displays only the edges of surfaces as white lines. (You can 
change this color choice in the Document Properties dialog 
box.) 

Colored Wireframe Mode
This option displays the model in colored wireframe mode. 
Lightscape displays all surface edges in their appropriate 
material color.

Hidden Line Mode
This option displays the model in hidden line mode. This mode 
looks similar to wireframe mode except surfaces block (hide) 
the display of other surfaces behind them. Lightscape displays 
all surface edges visible to the user in white. (The color you 
select in the Document Properties dialog box for wireframe 
mode will affect the color displayed in hidden line mode.) 

During the Solution stage, Lightscape superimposes on hidden 
line mode the mesh structure of the model generated during 
the radiosity processing.

Solid Mode
This option displays the surfaces of your model. Lightscape 
displays all surfaces in the material color. Display speed is 
greatly influenced by the number of surfaces in the model, as 
well as by the computer hardware. For complex models, it may 
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be more convenient to move interactively in wireframe mode 
and then display the surfaces in solid mode once the desired 
view is established. 

Outlined Mode
This option displays the model in solid mode with the addition 
of the surface geometry being outlined. Lightscape displays all 
polygon surfaces in the material color and displays all polygon 
edges in black. 

During the Solution stage, this option displays the solution 
mesh. This is useful for checking the impact of process 
parameter settings.

Display Options The following display options affect the appearance of the 
model in the display modes just discussed. In most cases, 
turning off these display options increases the display speed at 
the expense of image quality. The following display options can 
be toggled on and off.

Figure 3-13. Display Options Toolbar

Culling

Blending AmbientDouble

Antialiasing
Buffer

Textures Ray Trace
Area

Enhanced
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Double Buffer
During interactive viewing, double buffering produces a 
smooth display effect. With this option off, you’ll see the 
model as Lightscape draws it. This can cause a severe flicker. 

However, on some systems, turning double buffer off allows 
Lightscape to use more colors, which may greatly improve 
image quality.

Culling
Culling is a technique whereby the surfaces oriented away from 
the viewer position are not displayed on the screen. This 
technique is effective for looking “through” the walls of a room 
from an outside or aerial position.

Blending
When the blending option is on, transparent surfaces are 
blended with those behind them, giving the effect of 
transparency during the display of a file. (True calculation of 
transparency requires ray tracing.) When this option is off, all 
surfaces are displayed opaque (that is, as if transparency were 
set to zero).

Antialiasing
When the antialiasing option is on, lines displayed in wireframe 
modes are displayed antialiased which makes them appear much 
smoother. 
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Ambient
During the Solution stage, you can use this option to 
approximate the effect of undistributed light energy in the 
environment. This makes it possible to visualize the model 
more effectively during the early stages of the processing. (For a 
complete discussion of the ambient approximation, see the 
Lightscape Visualization System User’s Guide.)

Textures
In both the Preparation and Solution stages, you can turn 
texture maps on and off. Having the texture mapping on slows 
down the interactive display rates considerably, unless hardware-
supported mapping is available.

Enhanced
During the Preparation stage, you can turn this option on to 
display objects in the model with shading. This display mode 
makes it easier to see the smoothing of objects and to better 
determine where surfaces meet. 

Ray Trace Area
During the Solution stage, you can use this toolbar icon/menu 
item to drag a rectangle over an area of the Graphic Window, 
and then ray trace only that area. The results of the ray trace 
will be displayed to the screen. You can use this option to test 
the results of ray trace settings on a selected area before you ray 
trace your entire model, or to test the effect of material 
properties changes in the current model. You cannot save the 
results of the Ray Trace Area operation. The results will remain 
on the screen until the model is redrawn.
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Ray Trace Area
Options

During the Solution stage, this menu item displays a dialog box 
for setting Ray Trace Area options. You set these options before 
you select the area you wish to ray trace. See the Lightscape 
Visualization User’s Guide for more detailed information on these 
settings. 

Show Axis This menu item turns on the display of a set of X, Y, and Z axes 
which indicate the current view orientation. The axes appear in 
the lower-left corner of the model. Lightscape displays the X 
axis in red, the Y axis in green, and the Z axis in blue.

Auto-Redraw When this menu item is on, Lightscape redraws the model in 
the Graphic Window after every change to the model. If you do 
not need to see your changes immediately, you can improve 
performance by turning off this option so changes in material 
editing or texture alignment don’t cause an automatic redraw.

Auto-Orbit This menu item turns on an orbiting view of the model. The 
model continuously rotates around the focus point of the 
current view. Turn off auto-orbiting by deselecting this option 
in the Display pulldown. This option is only available for 
Perspective view.
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Reload Textures This menu item reloads all image files into materials that 
incorporate them. Use this function when you’ve modified an 
image map, changed an image map fileaname, or changed the 
Fixed Tile Size option and settings in the Material Properties 
dialog box.

Selecting Entities Before you can perform any action on an entity or entities, you 
need to create a selection set of the entities that you want to 
manipulate. A selection set can consist of a single entity or it 
can be a more complex grouping—for example, a group of 
surfaces on a single layer defined with the same material. 

Using the options in the Edit > Selection pulldown menu or the 
tools in the Selection toolbar, you can access various selection 
modes to build a selection set. Additionally, selection filters 
give you the ability to limit selection sets by entity type and 
material and luminaire properties. You can select a single entity 
or multiple entities when forming a selection set. When a 
selection set is defined, operations are performed on all of the 
entities in the set.

Figure 3-14. Selection Toolbar
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Selection Modes Lightscape provides three selection modes for building selection 
sets:

■ Select Exclusive
■ Select Additive
■ Pick Top Block

Select Exclusive
In this mode, any entity you click becomes the selected entity 
and all other entities are deselected. The currently selected 
entity is now the selection set. All selection filters affect this 
mode except for the Criteria selection filter.

Select Additive
In this mode, any entity you click is added to the existing 
selection set. Clicking on a selected entity, deselects that entity 
and removes it from the selection set. You can also use the 
Deselect All button to deselect the existing selection set. All 
selection filters are active for this mode except the Criteria 
selection filter.

Pick Top Block
Picks the top block in a block hierarchy. Where the currently 
selected block is a nested block, this mode selects the top block.
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Selection Tools Lightscape provides several selection tools for building and 
modifying selection sets. These include:

■ Select Single
■ Area Any
■ Area All
■ Select All
■ Deselect Area Any
■ Deselect Area All
■ Deselect All

Select (Single)
With this tool, you select single entities in the Graphic 
Window. Depending on the selection mode, the entity either 
becomes the selection set or is added to (or subtracted from) 
the current selection set. You can only select entities that meet 
the current filter setup. (See “Selection Filters” on page 3-35). 
In additive mode, entities can be deselected by selecting them a 
second time.

Area Any, Area All/Deselect Area Any, 
Deselect Area All
With these tools you can drag an outline box over the model, 
selecting or deselecting multiple entities at one time. Releasing 
the mouse button sets the outline box.

Area Any selects or deselects all entities that have any one of 
their vertices inside the selection outline box. Area All selects 
or deselects only those entities that have all of their vertices 
inside the selection outline box. 
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Only entities that meet the current filter setup are selected or 
deselected. 

Select All/Deselect All
With these tools you can select or deselect all entities in the 
model (not just the current view) that meet the current filter 
settings. For example, if you set the Blocks filter on and then 
invoke Select All, all blocks in the model are selected. If you are 
in Select Exclusive mode, then the current selection set is all 
the blocks in your model. If you are in Select Additive mode, 
then all the blocks are added to the existing selection set.

Selection Filters Lightscape provides selection filters for building selection sets:

■ Surface, Block, Luminaire
■ Criteria

Surface, Block, Luminaire 
When one of these filters is selected, only the specified entity 
type can be selected. Only one of these filters can be selected at 
a time. The default is Surface. 

Criteria
You open the Criteria list dialog box by choosing Edit > Selection 
> Criteria.

Only those surfaces whose material matches the materials in 
the Criteria list or the luminaires whose settings match those in 
the list can be selected. 
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The Criteria filter is used only when the Surface or Luminaires 
filter is selected and the Area Any/Area All or Select All 
operations are invoked. You can also select the Ignore Settings 
option to ignore any settings in the dialog box while using Area 
Any/Area All or Select All.

You add a material to the list by highlighting a material in the 
Materials Table and then choosing Add to Criteria List from the 
Materials context menu. You can remove materials from the list 
by clicking the right mouse button while on the Materials page 
in the Criteria dialog box and choosing Remove. You can also 
remove materials by double-clicking the material name on the 
Materials page in the Criteria dialog box.

Using the settings on the Luminaires page, you can choose to 
search for luminaires that have their Cast Shadows, Store Direct 
Illumination, or Ray Trace Direct Illumination options on or 
off. Simply select the settings you wish to use for the selection 
filter.
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 Chapter 4
Properties 
Properties are general parameters 

and defaults stored with each 

model. This chapter describes the 

properties used in Lightscape.
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Choose Edit > Properties to open the Document Properties dialog 
box.

The document properties are located on the following property 
pages:

■ Display
■ Units
■ Colors
■ Fog
■ Path Lists
■ Display Interactivity

Display Properties The Display properties control how Lightscape displays a 
model on your monitor. Figure 4-1 shows the Display page.

Figure 4-1. Display Page
4-2 Chapter 4, Properties



Brightness Controls the brightness of the displayed image on 
your monitor. The setting of this control does 
not affect the actual lighting levels in the model.

Contrast Controls the contrast of the displayed image on 
your monitor.

Ambient When you use the Ambient Approximation 
technique during the Solution stage, this control 
sets the percentage of the available ambient light 
to use. (Ambient Approximation is discussed in 
detail in the Lightscape Visualization System User’s 
Guide.)

Luminaire 
Icon Size

Controls the size of the icon that represents the 
energy distribution assigned to a luminaire. By 
default, Lightscape sizes these icons to 
correspond to the size of the luminaire. To 
confirm the luminaire placement of small lights 
in large models you may need to increase the 
icon size.
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Units Properties Units properties determine the default units you work with in 
the model. Figure 4-2 shows the Units page. Lightscape displays 
the current length units in the Status Bar. 

Figure 4-2. Units Page

Length Selects the units of length. Your choices are 
millimeters, centimeters, meters, kilometers, 
inches, feet, and miles. 

Note that changing the units does not change the 
size of the model. For example, a surface that is 
1 meter long will be 3.28 feet if feet are the 
selected units. 

Lighting Selects the unit system to use for lighting. Your 
choices are International and American.

Time Selects the time units to use for an animation 
setup. Your choices are seconds, minutes, and 
hours.
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Colors Properties The Colors properties set the default colors for your display. 
Figure 4-3 shows the Colors page. 

Figure 4-3. Colors Page

Use the color sliders to choose the color you want for each 
setting. You can use HSV or RGB values.

As you adjust the color sliders, Lightscape displays the new 
color in the box adjacent to the sliders. When you are satisfied 
with the selected color, click one of the left arrow buttons to 
apply the color to a particular setting. 

Background Sets the color displayed in the background of the 
Graphic Window. 

Wireframe Sets the color of the lines in wireframe display 
mode.

Mesh Sets the color of the mesh in outlined display 
mode.
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You can make further adjustments to each color by clicking the 
right arrow button corresponding to the color you wish to edit. 
Lightscape displays the color you selected in the box adjacent to 
the color sliders. The color is now the active color so you can 
edit it.

Fog Properties Fog provides better depth cueing by making items that are at a 
distance appear dimmer. Fog is simply a display technique; it 
does not affect, nor is it affected by, the lighting of the scene. 
Figure 4-4 shows the Fog page. 

Figure 4-4. Fog Page
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Function Selects the type of Fog function. Your choices are 
Disabled, Fog, Haze, and Linear. 

Disabled is the default setting and indicates not to 
use the fog function. 

Linear fog is completely clear at the near plane and 
completely opaque at the far plane (as set in the 
View Setup dialog box). The density increases 
linearly from the near plane to the far plane. This is 
useful for depth cueing but does not look like real 
fog.

Fog looks like a uniformly dense fog and becomes 
completely opaque at some distance, depending on 
the density setting. This is what fog usually looks 
like in reality.

Haze is like fog except that the opacity changes in a 
more complex way. For the same density setting, 
fog appears to have a uniform density and obscures 
things nearby, while haze seems to get much 
denser in the distance and leaves nearby objects 
almost unobscured.

Density Sets the density of the selected Fog function. The 
range is 0 to 1, with 1 representing the densest fog 
effects.

Fog Color Selects the color for the selected Fog function.

You choose the color you want using HSV or RGB 
values.
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Path Lists Path Lists properties control the specification of the path lists 
for your model. The path list is a list of directories Lightscape 
searches to find a file. You can specify Luminaire and Texture 
path lists, as well as add and delete directories from these paths 
on the Path Lists page. Figure 4-5 shows the Path Lists page.

Figure 4-5. Path Lists Page

Path List Selects the path list to edit. Your choices are 
Luminaire Distributions and Textures. The 
directories currently included in the path list are 
shown in the single selection list. 

You can select an entry in the current path list 
and use the up and down arrow buttons to 
change the order of the paths. Lightscape 
searches the paths in order, starting from the top 
of the list and going down.

Directory An input field for editing a single path. The 
directory list shows the subdirectories (if any) of 
the path currently displayed in the input field. 
Select an entry from the path list box to place it 
in the input field as a starting point for editing.
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The Browse Directory dialog box allows you to easily select a 
directory to add to your path list. You can select any local or 
network drive. 

Figure 4-6. Browse Directory

Browse Starts a directory browser which allows you to 
select a path to add to the list.

Add Adds to the path list the path that is in the 
Directory input field. If the path is already in the 
list, nothing changes.

Remove Removes from the list the path you have selected.

Directories Shows the current directory displayed in the 
browser.

Drives Allows you to select alternate local or network 
drives.

Network Allows you to connect to network drives which 
you can then select from the Drives combo box.
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Display Interactivity 
Properties 

Navigating through complex models with a large number of 
surfaces in real time requires more processing power than 
many desktop computers have. By choosing to decrease the 
quality of the display, you can usually increase performance. 
The Display Interactivity properties control the amount of 
redrawing required while working in your model. Figure 4-7 
shows the Display Interactivity page. 

Figure 4-7. Display Interactivity Page
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Interactive 
Speed

Selecting Redraw on Mouse Release causes a 
redraw at full quality at the end of user 
interaction (releasing the mouse button after 
interactively adjusting the view of the model). 

Selecting All Redraws at Interactive Speed 
redraws the Graphic Window according to the 
Draw Every Nth Face or Level of Detail settings. 
For example, if you set Draw Every Nth Face to 
2, all redraws will display only every second face.

You can press F7 to redraw the Graphic Window 
at full quality display at any time.

Draw Every 
Nth Face

To retain interactive display speeds when 
working with complex models (models with a 
large number of surfaces), you can use this 
control to reduce the number of surfaces 
displayed. For example, setting Draw Every Nth 
Face to 2 displays every second surface, with a 
corresponding increase in display speed.

The default setting is 1 (display every surface).

In Solution stage, adjusting Draw Every Nth Face 
resets the value of Level of Detail to 100.

Click Preview to preview your changes without 
exiting the dialog box.
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Level of 
Detail

During the Solution stage, you can use this 
option to control display quality more selectively 
than with the Draw Every Nth Face option.

The Level of Detail option controls the amount 
of detail displayed, rather than simply controlling 
the number of surfaces displayed. This allows 
you to retain a more faithful view of the scene 
while accelerating interactivity. 

When the Level of Detail is set below 100, 
Lightscape begins to degrade the quality of the 
image. The system avoids redrawing distant 
objects and smaller polygons. At lower settings, 
more detail is dropped from the display.

The default setting is 100 (maximum level of 
detail).

Adjusting Level of Detail resets the value of 
Draw Every Nth Face to 1.

Click Preview to preview your changes without 
exiting the dialog box.

Max. Display 
Texture Size

Scales the size of the textures used for interactive 
display. (This option does not effect the size of 
textures used for radiosity or ray tracing.) 
Choices include: Unlimited, which displays 
textures at normal size; 256 x 256; 128 x 128; 
64 x 64; and 32 x 32. At lower settings, the 
texture is scaled down and Lightscape attempts 
to display an accurate representation of the 
texture with less detail. Reducing the size of the 
texture can significantly improve display speed.
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